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Preface 

The purpose of this manual is to provide you with the information you need to use the 
latest enhancements to the Panel List window in the iCare (BQI) population 
management application. 

This manual contains reference information about iCare views, examples of its 
processes, and step-by-step procedures to show you how to perform activities related 
to the Panel List window in the latest version of the iCare application. 

For more information about iCare basic functionality, iCare usage, or training for 
iCare, you may consult these resources: 

• iCare – IHS OIT available at http://www.ihs.gov/icare/ 

• iCare Training available at http://www.ihs.gov/icare/training 

• Join the iCare listserv by sending an e-mail to icare@listserv.ihs.gov 

iCare Graphical User Interface 
The iCare GUI is intended to allow healthcare providers to see a more complete view 
of patients with multiple conditions, while maintaining the integrity of the user-
defined, disease-specific registers. 

iCare can help IHS providers by: 

• Proactively identifying and managing different groups (populations) of patients 
who share user-defined characteristics. 

• Providing an integrated view of a patient’s conditions that would minimize siloed 
care management. 

• Providing an intuitive and integrated interface to the diverse patient data elements 
of the RPMS database. 

• Facilitating providers with a review of clinical quality of care measures for their 
own patients to enable improvement in the quality of healthcare delivery. 

• Enabling views of traditional healthcare information from the perspectives of 
community, population and public health. 

• Providing the default tag selection as Proposed and Accepted. You can change the 
tag selection for any record by selecting or de-selecting any checkbox. 

• Clicking the use AND? check box when there are multiple tags selected. The And 
option searches for patients who have ALL of the user-defined tags. 

http://www.ihs.gov/icare/
http://www.ihs.gov/icare/training
http://vdentfsasp01/sites/CIS/IHS_Program/iC/WDL/icare@listserv.ihs.gov
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Who Should Use iCare? 
Any provider who needs to identify a group of patients for long-term management or 
to create a temporary list should think about using iCare. Do you fit any of the 
following scenarios? 

• I am a nurse at a facility that assigns a primary care provider to each patient. 
Every day, I want to create a list of scheduled patients for two different doctors in 
my clinic. 

• I want to identify which of my patients are considered obese so I can recommend 
nutrition counseling. 

• Because providers at our clinic have performance goals related to annual GPRA 
clinical measures, I want to identify which of my patients are missing key clinical 
data. 

• Our Women’s Health Clinic wants to focus on two clinical performance 
improvement initiatives this year. We want to identify the performance problem 
areas for female patients between the ages of 18 and 50. 

• I am one of two part-time case managers for a group of children, and I want to 
create a patient list that we both can use. 
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1.0 Introduction 
iCare is a computer desktop software application that provides a robust method of 
interacting with the IHS Resource and Patient Management System (RPMS). It 
retrieves key patient information from various components of the RPMS database and 
brings it all together under a single, user-friendly interface. iCare helps providers 
manage the care of their patients by providing the ability to group common categories 
(e.g., age, diagnosis, community) and create panels that personalizes the way they are 
able to interact with and gain valuable insights from patient data. 

The information included in this Panel List manual covers Panel List functionality in 
iCare Version 2.8.  For more information about iCare basic functionality, iCare usage, 
or training for iCare, you can consult the resources listed above in the Preface. 

1.1 Background 
Along with the rest of the healthcare industry, IHS has already developed a set of 
chronic condition management (or register) applications, including for diabetes, 
asthma, and HIV. This type of application provides a way for healthcare providers to 
manage a specific group (register) of patients for a single disease state. Register 
management applications assist healthcare providers to identify high-risk patients, 
proactively track care reminders and health status of individuals or populations, 
provide more standardized and appropriate care by embedding evidence-based 
guidelines, and report outcomes. 

Many patients, however, have more than one diagnosed disease. For instance, at the 
current time within the Indian Health system, a diabetic asthmatic woman could be a 
member of four RPMS registers (diabetes, asthma, women’s health, and 
immunizations). This siloed approach to patient care could potentially result in 
fragmented care and could increase the risk of inadequate patient care management 
due to misidentification of the true level of risk. 
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2.0 System Navigation 

2.1 Panel List View 
The Panel List view displays a list of your current panels, including the default panel, 
the panels created by the user, and the panels shared with you by other users. 

 
Figure 2-1: Sample Panel List view 

The Startup View tab on User Preferences determines the view that will display 
when you first login to iCare. 

To view the Panel List window, do one of the following: 

• If you are in Split View, the Panel List will be in the left frame. 

• If you are not in Split View, you need to click the Panel List tab. 

• If you are in another window, select the iCare Main option from the Window 
menu. 
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3.0 Package Management 
The following provides information about using the iCare features for the Panel List 
view. 

3.1 User Preferences 
This section focuses on the user preferences that are used by the Panel List window. 

 
Figure 3-1: Sample User Preferences window 

After the User Preferences window is complete, click OK and the user preferences 
will be in effect for the operation of the iCare application. (Otherwise, click Cancel.) 

Startup View Tab 
The selection on Startup View tab determines the tab that displays when you first 
access the iCare application. 
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Figure 3-2: Sample Startup View tab on User Preferences 

Select the Panel List option button if you want the Panel List to be the first window 
to display when you access the iCare application. 

3.2 Panel Properties 
You can view the properties of a highlighted panel by selecting File | Panel | 
Properties (or by selecting the Properties option on the context menu). The Panel 
Properties dialog displays. Click OK to dismiss the dialog. 

Figure 3-3: Sample Panel Properties dialog 
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• The General tab provides information about the panel name, when the panel was 
created and who created it, the panel description, and any filters used to create the 
panel. 

• The Update History tab provides information about the auto repopulate status, 
when the panel definition was last modified and who modified it, when the patient 
list was last populated and who modified it, and when the patient list was 
manually updated. 

• The Shared/Access tab provides information about the shared users for the 
current panel and their access rights. 

• The Flag Setup tab provides information about the timeframes for the flag types 
(defined in User Preferences). 

3.3 Free Text Fields 
Free text fields are those fields that you can type information into; these fields do not 
have a drop-down list from which to select an option to populate it. 

An example of a free text field is the Panel Name field (when creating/editing a 
panel definition). 

There is a context menu to aid in editing the text. 

 
Figure 3-4: Context menu to aid in editing text 

These options operate just like those in any Windows application. 
Undo: Removes the last edit action. 

Cut: Removes the selected text from its current position and places it on the 
Windows clipboard. 

Copy: Copies the selected text and places it on the Windows clipboard (the text is not 
removed). 

Paste: Copies the contents of the Windows clipboard and places it in the field at the 
current cursor position. 

Delete: Removes the selected text from its current position. 
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Select All: Highlights all the text in the current field. 

3.4 Print Preview 
The Print Preview window contains several features about reviewing and printing 
the current document. 

 
Figure 3-5: Sample Print Preview dialog 

The Print Preview window contains two panels, where the left panel displays the 
pages in the document and the right panel displays a larger version of the page 
selected in the left panel. 

The following table provides information about the various buttons on the Print 
Preview window. 

Button Description 

 
Used to output the contents of the document. 
Also available by selecting Print option on the File menu. 

 
Used to move the red rectangular box on the selected page in the left panel. 
As you move the Hand Tool, this changes the display in the right panel. This 
is used to view information in a particular part of a page. 
Also available by selecting the Hand Tool option on the Tools menu. 
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Button Description 

 
Used to get a screen capture of a specified rectangular area. This screen 
capture copies the area to the Windows clipboard. Then you can paste the 
copy in a particular field, for example, or another application like MS Word. 
Also available by selecting the Snapshot Tools option on the Tools menu. 

 
Used to specify the zoom magnification. Click the button and then move to 
the area where you want to apply to zoom. Right-click on the area and 
select the zoom magnification option from the context menu. 
Also available by selecting the Dynamic Zoom Tool option on the Tools 
menu. 

 
Used to zoom out by clicking the button in an area in the right panel (the 
image becomes smaller). 
Also available by selecting the Zoom Out option on the View menu. 

 
Used to zoom in by clicking the button in an area in the right panel (the 
image becomes larger). 
Also available by selecting the Zoom In option on the View menu. 

 
Used to cause the image in the right panel to display to its maximum page 
width (usually enlarges the image). 
Also available by selecting the Page Width option on the View menu. 

 
Used to cause the image in the right panel to display the image with no 
page margins showing. 
Also available by selecting the Margin Width option on the View menu. 

 Used to display the image and its page margins in the right panel. 
Also available by selecting the Whole Page option on the View menu. 

 
Used to automatically cause the image in the right panel to zoom out (you 
do not click in the panel). 
Also available by selecting the Zoom Out on the View menu. 

 
Used to automatically cause the image in the right panel to zoom in (you do 
not click in the panel). 
Also available by selecting the Zoom In on the View menu. 

 
Used to cause all the pages to display in the right panel. 
Also available by selecting the Continuous option on the View menu. 

 
Used to specify the page layout. 

 
Move through the pages in the document by using the arrow buttons on the second 
line in the toolbar. 

 
Figure 3-6: Buttons used to move through the pages of the document 

The same options are available by selecting View | Go To (and on the context menu 
for the right panel). 
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Use the Zoom  field (or select the Zoom option on the View 
menu) to specify the zoom magnification for the right panel by selecting from the 
drop-down list. 

Use the Close button to close the Print Preview dialog. This same action is available 
by selecting File | Exit. 

Select File | Page Setup to access the Page Setup dialog. 

 
Figure 3-7: Sample Page Setup dialog 

Use the Page group box to specify the paper size and source. 

Use the Orientation group box to specify the orientation of the output. 

Use the Margins group box to specify the various margins widths in inches. 

Click Printer to access the Printer dialog where you choose the printer to output the 
contents of the document. 

After the Page Setup dialog is complete, click OK to save the page setup options. 
(Otherwise, click Cancel.) 
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3.5 iCare Package Manager Functions 
When you have the Package Manager security key, you can access the functions by 
selecting Tools | iCare Package Manager on the iCare main window. 

 

 

Figure 3-8: iCare Package Manager Functions 

3.5.1 iCare User Access Management 
The iCare User Access Management option accesses iCare User Access 
Management dialog. 

When this dialog is complete, click OK to save your changes. (Otherwise, click 
Cancel.) 

Figure 3-9: Sample iCare User Access Management dialog 

For those with the appropriate permissions, you can assign roles to a particular user, 
scroll to the name on the iCare User Access Maintenance dialog and select the 
appropriate check boxes for the roles. If you want to remove an assigned role, de-
select the particular check box.  

Note: The BH User column cannot be changed. 

Each column heading has hover help. 

Some check boxes are checked, and the background is dark. 

iCare Package Manager access supersedes CMET Package Manager and Editor 
permissions. However, iCare Package Manager access does not supersede Employer 
and BH access due to the sensitive nature of the patient data involved. 
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3.5.1.1 Existing RPMS Editor Access 
The users displayed on this list (those with the iCare user icon ( ) in first column) 
have been given existing Editor or Manager level key(s) to at least one of the 
following case management applications: 

• Case Management System (ACM) 

• Diabetes Management System (BDM) 

• HIV Management System (BKM) 

• Immunization (BI) 

• Patient Chart Problem List 

• Women’s Health (BW) 

3.5.1.2 Help Menu 
Click the Help menu to view the following information: 
The users displayed on this list have been given basic access to the iCare application 
by your Site (IT) Manager. You cannot give Editor or Package Manager access to 
iCare to a user who does not have basic access. See your Site Manager to require 
basic iCare access for other users. 

This message applies to the User with iCare Access column. Click OK to dismiss 
the message. 

3.5.1.3 Users with iCare Access 
This column is a list of RPMS users who have been given access to the iCare 
application by the Site (IT) Manager. 

3.5.1.4 iCare Package Manager 
The iCare Package Manager has all read/write access as defined for other user levels. 
This person can do the following: 

• Assign all other access roles in iCare: iCare Package Managers, CMET Package 
Managers, Editors, and Taxonomy Editors. 

• Access Patient Information associated with Community Alerts. 

• Has all read/write access as defined for other user levels. 

• Reassign existing iCare panels to iCare users. 

Note: Taxonomy Editor Access Management is assigned through 
the Taxonomy Maintenance/ Taxonomy User Access 
Window from the Tools menu. 
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The iCare Package Manager has the highest level of permissions; hence, the iCare 
Package Manager will have access to all items accessible by the CMET Package 
Manager. 

The iCare Package Manager does everything an editor does and can access the list of 
patients who has triggered the Community Alerts. This person also assigns Editor 
access to other users. In addition, this person can assign the CMET Package Manager 
role. 

3.5.1.5 CMET Package Manager 
The CMET Package Manager can establish the CMET site parameters related to 
Tickler Timeframes and Batch Processing. CMET Package Managers have all 
read/write access as defined for other user levels. 

3.5.1.6 Editors 
Editors in iCare will have read/write access to: (1) PCC Historical Data Entry; (2) 
Care Management data; (3) Family History and Reproductive Factors (Snapshot); (4) 
Designated Specialty Provider Management system (DSPM); (5) Problem List; and 6) 
CMET Worksheet. 

The Editor role will give the person the right to edit the care management function 
(e.g., HMS Care Management). It also allows the person to enter Historical Data. 

3.5.1.7 Employer Group Access 
Employer Group Access gives the user the ability to define a panel based on the 
Employer option in Panel Definition. They will also have visibility for the Employee 
Health option on the Panel View: Care Mgmt tab. Both the definition and Care Mgmt 
feature will not be visible to users who do not have permission. 

3.5.1.8 BH Alerts 
Exclude non-BH alerts. 

3.5.1.9 BH User 
User with existing BH access. This cannot be edited from iCare screens. 

3.5.1.10 IPC Package Manager 
The IPC Package Manager can establish site parameters related to the background job 
and microsystem definition for IPC tabs in iCare. 

3.5.1.11 DSPM Editor 
The DSPM Editor can update patient provider information in iCare. 
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3.5.2 Reassign Panels 
The Reassign Panels option displays the Reassign Panels dialog. 

 

 

Figure 3-10: Reassign Panels dialog 

This dialog allows the iCare Package Manager to reassign panels from one user to 
another user. 

Reassign From: Select the user whose panels you want to reassign from the drop-
down list. 

Reassign To: Select the user to whom the panels are to be reassigned from the drop-
down list. 

Populating the first two fields activates the Select button. Click Select to access the 
Add/Remove Panels dialog. 

Figure 3-11: Sample Add/Remove Panels dialog 

After the Add/Remove dialog is complete, click OK and the panels listed in the 
Current Panels group box will populate the Panels field on the Reassign dialog. 
(Otherwise, click Cancel). 
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After the Reassign Panels dialog is complete, click OK and the reassigned panels of 
the Reassign From user are removed from that person’s panel view. The reassigned 
panels will display in the Reassign To user panel view. (Otherwise, click Cancel.) 

3.6 iCare Taxonomy Editor Function 
The iCare Taxonomy Editor holds the security key (BQIZTXED) allowing that 
person to read/edit iCare taxonomies. 

You access the iCare Taxonomy View/Edit dialog by either selecting Tools | 
Taxonomy Maintenance | View/Edit Taxonomy Entries. 

 
Figure 3-12: Sample iCare Taxonomy View/Edit dialog 

Note: If you do not hold that security key, you can only view the 
information on the dialog. The following information 
displays: You do not currently have access rights to edit 
taxonomies. In order to edit taxonomy entries, you will 
need to have the iCare Taxonomy Editor security key 
(BQIZTXED) added to your RPMS user account. 

When you first access this view/edit dialog, all parts of the tree structure will be 
collapsed. You need to expand one of the tree parts and find the taxonomy you want 
to edit. 
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In general, select the taxonomy from the list in the left group box that you want to 
view. This causes the Add and Remove buttons to display in the right group box of 
the dialog. 

Please note that not all taxonomies can be edited. iCare will display a message on the 
view/edit dialog when this condition exists. Site populated taxonomies can only be 
edited by users with appropriate access. 

The difference between Apply and OK is that the Apply button is used when you add 
more than one taxonomy value to the iCare Taxonomy View/Edit dialog. 

3.6.1 Add Taxonomy Values 
Click the Add button to create values for a selected item in the left group box. The 
application displays the Select Taxonomy Item dialog. 

 
Figure 3-13: Select Taxonomy Item dialog 

Use the Search field to search for a taxonomy item. Highlight the item you want to 
add and click Select. The application checks to see if it is already there. 

• A warning message will display if the item already exists (click OK to dismiss the 
message); after clicking OK, you return to the iCare Taxonomy View/Edit 
dialog. 

• If it does not exist, it appends the selected item to the bottom of the list. 
After you finish adding taxonomy values, click Apply to save your changes. If you do 
not click Apply and try to move to another taxonomy or another part of the iCare 
application, the Save Taxonomy changes? information message displays, asking if 
you want to apply the changes now. In this case, click Yes to apply the changes 
(otherwise, click No). 

You can repeat adding items to various taxonomies. When you are finished using the 
iCare Taxonomy View/Edit dialog, click OK to save (otherwise, click Cancel). 
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3.6.2 Remove Taxonomy Values 
If you want to remove one or more items from the list, highlight the item(s) and click 
Remove. The Confirm taxonomy item remove message displays. Click Yes to 
remove the items (otherwise, click No). You remain on the iCare Taxonomy 
View/Edit dialog. 

3.6.3 View Report of All Taxonomies Button 
Click the View Report of All Taxonomies button to display the Taxonomy Report 
dialog. 

 
Figure 3-14: Taxonomy Report 

This dialog provides information about various Taxonomy Categories (listed in 
alphabetical order). 

See Section 3.7 for information about the File menu and buttons on the dialog. 

3.7 Dialog Functionality 
Several places in iCare you will be viewing a dialog. For example, if you double-click 
on any row in the Recent Visits group box on the Cover Sheet of the Patient 
Record window, you will view a dialog. 
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Figure 3-15: Sample Visit Detail dialog 

You can take the following actions on this dialog: 

• Navigate through the information by using the scroll bar. 

• Click the Find ( ) button to access a search tool to find data in the current 
window. This button works like the Search button. 

• Click the Font ( ) button to display the Font dialog. 

 
Figure 3-16: Font dialog 

Here you can change the Font name, style, and size of the text in the dialog (applies 
to all the text). In addition, you can add effects like Strikeout and Underline. These 
functions perform like those effects indicated in MS Word. 
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Change the Script option if you need to the see the text displayed in another language 
and you have that language pack installed on your computer. If the language pack is 
not installed, the display does not change by selecting another script. 

Click OK to apply your changes to the text in the current dialog. These changes are 
only effective for the current view of the dialog. (Otherwise, click Cancel.) 

• Click the Copy ( ) button to copy the selected text to the Windows clipboard. 

• Click the Print Preview ( ) button to view the Print Preview dialog. You 
can print the contents of the dialog from this dialog. 

• Click the Print ( ) button to display a print dialog where you specify the 
printer to output the contents of the dialog, the page range, and number of copies. 

The File menu contains the print actions (like the Print Preview and Print buttons), 
the Page Setup function, the find and copy functions, as well as a Close function 
(dismisses the dialog). 

3.8 Taxonomy User Access 
Editing site populated taxonomies can affect many existing processes in RPMS. For 
this reason, Taxonomy Edit access is carefully assigned to a limited number of users 
and only after discussion with the CRS (GPRA) coordinator. 

Select Tools | Taxonomy Maintenance | Taxonomy User Access to access the 
iCare Taxonomy User Access Management dialog. 

 
Figure 3-17: iCare Taxonomy User Access Management for Taxonomy Editor 
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Each of the column headings has hover help. 

3.8.1 Existing RPMS Editor Access 
The users with the iCare user icon ( ) in first column are RPMS users with existing 
Manager level keys to at least one of the following applications: CRS (BGP), 
Diabetes Management (BDM), HIV Management System (BKM), and/or Women’s 
Health (BW). 

3.8.2 Users with iCare Access 
This column is a list of RPMS users who have been given access to the iCare 
application by the Site (IT) Manager. 

3.8.3 Taxonomy Editor 
Those with a checkmark are taxonomy editors who can add and delete members from 
any Site Populated Taxonomies related to either laboratory tests or medications. 

3.8.4 Help Menu 
The following information displays when you click the Help menu: 
The users displayed on this list have been given basic access to the iCare application 
by your Site (IT) Manager. You cannot give Editor or Package Manage access to 
iCare to a user who does not have basic access. See your Site Manager to require 
basic iCare access for other users. 

Change RPMS Server/Login 
The Change RPMS Server/Login option appears on the File menu. Select this 
option to access the iCare 2.8 GUI Login dialog. 
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Figure 3-18: Sample iCare 2.8 GUI Login dialog 

RPMS Server 

Click the drop-down list to access the RPMS Server Management dialog that 
displays a list of possible connections. 

Figure 3-19: Sample RPMS Server Connection Management dialog 

Select an option on the grid or use the New function to create a new connection. 

Click New to access the Edit RPMS Server Connection dialog. 
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Figure 3-20: Edit RPMS Server Connection dialog 

Do not select the Default RPMS Server Connection or Use Windows 
Authentication check boxes. 

Connection Name 
Type the name of the connection in this field. This is the name that will appear on the 
RPMS Server Connection management dialog. 

Server Address/Name 
Type the number, including punctuation, of the server’s IP address. An IP address is 
typically four groups of two or three numbers, separated by a period (.), e.g., 
161.223.99.999. Your Site Manager will provide this information. 

Server Port 
Type the number of the server port. Your Site Manager will provide this information. 

Server Namespace 
If your site has multiple databases on one server, you will additionally need to type 
the namespace, which is typically a text string, e.g., DEVEH. 

Use default namespace 

Select this check box if the Server Namespace is the default one you want to use. 

After completing the fields, the Test Connection button becomes active. Click this 
button to access the Test Login dialog. Populate the Access Code and Verify Code 
fields and then click OK. 
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• After clicking OK, if the connection is correct, the application displays the 
Connection Test message that states: “RPMS login was successful.” Click OK to 
dismiss the message. 

• Otherwise, the application will display an error message; click OK to return to the 
Test Login dialog. 

After the Edit RPMS Server Connection dialog is complete, click OK to have the 
server connection appear on the RPMS Server Connection management dialog. 
Otherwise, click Cancel. 

After the RPMS Server Connection Management dialog is complete, click Save 
(otherwise, click Cancel).  

After clicking Save, the application displays the login dialog to the application. 

3.9 iCare Site Parameter Options 
You access the iCare Site Parameters on the Tools menu. 

 
Figure 3-21: iCare Site Parameter options 

3.9.1 Employers 
Use the Employers option to determine the list of employers that should be used for 
employee health. This is a table of all employers in your RPMS system, many of 
which can have several different name spellings. Select the Employers option to 
access iCare Site Parameters – Employers dialog. 
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Figure 3-22: Sample iCare Site Parameters – Employers dialog 

The current employers are listed in the Employers field. 

Use the Edit button to edit the Employers field. Click Edit to access the 
Add/Remove Employers dialog. 

 
Figure 3-23: Sample Add/Remove Employers dialog 

When the Add/Remove dialog is complete, click OK and the options in the Current 
Selections group box populates the Employers field on the iCare Site Parameters – 
Employers dialog. (Otherwise, click Cancel.) 

3.9.2 Pregnancy 
Use the Pregnancy option to determine the definition of pregnancy by a choice of 
two methods for calculation. Select the Pregnancy option to access the iCare Site 
Parameters – Pregnancy dialog. 
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Figure 3-24: Sample iCare Site Parameters – Pregnancy dialog 

Type 
The default method is based on CDC influenza disease-reporting (ILI) logic where 
pregnancy must be medically indicated in the last 60 days. Select an option from the 
drop-down list to populate the Type field. If the ILI is selected, then the Time 
Frame field does not display on the dialog. 

Time Frame 
The second method of calculation is iCare-specific and can be set to where pregnancy 
has been medically indicated in the last 1-month to 9-month time period. Select an 
option from the drop-down list to populate the Time Frame field. 

When the dialog is complete, click Save to save the pregnancy parameters. 
(Otherwise, click Cancel.) 

3.9.3 Inactivity Time Out 
iCare incorporates time out features to ensure secure usage in clinical community 
workstation environments. Use the Inactivity Time Out option to determine the 
inactivity time out, inactivity warning message time out, and application shutdown 
time out. 

Select the Inactivity Time Out option to access the iCare Site Parameters – 
Inactivity Time Out dialog. 
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Figure 3-25: Sample iCare Site Parameters – Inactivity Time Out dialog 

Inactivity Time Out 
Select an option from the drop-down list that determines the number of minutes 
before the application locks the application from further use by the current user. 

Inactivity Warning Message Time Out 
Select an option from the drop-down list that determine the number of seconds before 
the Inactivity Warning Message displays. 

Application Shutdown Time Out (in minutes) 
Select an option from the drop-down list that determines the number of minutes 
before the application will shut down. 

3.9.4 CMET Site Parameters 
Use the CMET Site Parameters option to determine the tickler timeframes and 
batch processing for CMET. Select the CMET Site Parameters option to access the 
RPMS iCare – CMET Site Parameters window. 
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Figure 3-26: Sample RPMS iCare – CMET Site Parameters dialog 

Tickler Timeframes 
The Tickler Timeframes tab sets the ticklers (like reminder notices) for Findings, 
Follow-up Decision, and Patient Notification. 

Each field has a drop-down list from which to select an option. When a timeframe 
date is passed and the step has not been entered, the Tickler will display. 

After you change one or more settings click OK. The application populates the Last 
Edited field with the date, and the By field with the person who changed the tickler 
timeframe data. (Otherwise, click Cancel.) 

The application provides Ticklers designed to remind the user that a CMET is tracked 
and requires attention. There are three types of Ticklers: 

• Finding Ticklers, based on the event date. The Tickler is initiated from the date 
of the event. 

• Follow-up Decision Ticklers. Ticklers are initiated from the date the Findings 
were entered. 

• Patient Notification Ticklers. Ticklers are initiated from the date the Follow-up 
recommendation is entered. 

Timeframes for each of the three steps is based on the preceding step. For example, a 
Follow-up Decision Tickler is based on the date the Finding was entered. 
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Batch Processing Tab 
The Batch Processing tab sets the timeframe and notification type for the Pap Smear 
and Mammogram Screening events with normal results. In addition, you can set the 
type of Normal Finding for the Mammogram Screening event. 

 
Figure 3-27: Sample Batch Processing tab 

The Notification Type field defines how the patient will be notified about the Pap 
Smear or Mammogram Screening, for example, by telephone. The default is 
LETTER. 

The Timeframe consideration is based on a typical (or average) length of time it 
would take to receive results, to consider the next steps, and to notify the patient. 

The option selected for the Normal Finding for Mammogram Screening field 
determines what is a “normal” finding. 

Each field has a drop-down list from which to select an option. 

After you change one or more settings and click OK, the application populates the 
Last Edited field with the date and the By field with the person who changed the 
batch processing data. (Otherwise, click Cancel.) 

Events Tab 

The Events tab allows the setting of default value for CMET events. 
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Figure 3-28: Sample Events tab 

• Select the row with the event to modify. 

• Set PCC File type. 

• Set Default Value. 

• Click Save to save changes. 

3.9.5 IPC Site Parameters 
Use the IPC Site Parameters option to determine the following IPC parameters: (1) 
IPC Version, (2) day of month to run IPC data collection, (3) clinics where the patient 
receives primary care. 
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Figure 3-29: Sample iCare Site Parameters – IPC dialog 

IPC Version 
Select the IPC Version using the drop-down. 

Day of month to run IPC data collection 
Select from the drop-down list the option that specifies the day of the month on which 
to run the iCare IPC data collection. 

Clinics where the patient receives primary care 
This field determines the type of local clinics to be designated as primary care. Click 
Edit to access the Add/Remove Visit Clinics dialog. 
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Figure 3-30: Sample Add/Remove Visit Clinics dialog 

When the Add/Remove dialog is complete, click OK and the options in the Current 
Selections group box populates the Clinics where the patient receives primary 
care field. 

3.9.6 Divisions 
Use the Divisions option to determine the divisions for your site. Select the Divisions 
option to access the iCare Site Parameters – Divisions dialog. 

 
Figure 3-31: Sample iCare Site Parameters – Divisions dialog 

The listed divisions are those used by your site. Click Edit to access the 
Add/Remove Divisions dialog. 
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Figure 3-32: Sample Add/Remove Divisions dialog 

When the Add/Remove dialog is complete, click OK and the options in the 
Current Selections group box will populate the Divisions field on the iCare Site 
Parameters – Divisions dialog. (Otherwise, click Cancel.) 

3.9.7 DM Audit 
Use the DM Audit option to set the register used by DM Audit. Select the DM Audit 
option to access the iCare Site Parameters – DM Audit dialog. 

Figure 3-33: Sample iCare Site Parameters –DM Audit dialog 

The listed registers are those available at your site. Use the drop-down to select the 
register to associate with DM Audit.   

3.10 Manage Templates 
The Manage Templates option provides a means for defining multiple template 
layouts. Templates can also be created and added so that anyone can download and 
use them. 

The Manage Templates option appears on the Tools menu. Select it to access the 
Template Management dialog. 
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Figure 3-34: Sample Template Management dialog 

The Your Templates group box contains a list of all a specific user’s defined 
templates and the layout contained in each template. 

The Public Templates group box contains a list of all templates at the site that are 
available to be downloaded to the list in Your Templates. 

3.10.1 View 
Use the View action to view a selected template. This is a view-only display. 

3.10.2 Upload 
The Upload action is available in the Your Template group box. Select a template to 
upload and then click Upload. The selected template will appear in the Public 
Templates group box. The author will be you (the person who executed the Upload). 

3.10.3 Download 
The Download action is available in the Public Templates group box. Select a 
record to download and then click Download. The selected template will appear in 
the Your Templates group box. In the Template field, your name (the person who 
executed the Download) will appear after the name of the template. 
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3.10.4 Delete 
The Delete action is available in the Your Templates and Public Templates group 
boxes and applies to your templates only. Select a record to delete and then click 
Delete. The Delete Template information message display confirming the deletion. 
Click Yes to delete (otherwise, click No.) 

3.10.5 Edit 
The Edit action is available in the Your Templates group box. Select a template to 
edit and then click Edit. You access the template of columns for the selected 
template. Section 3.10.6.1 provides information about how to use this template. 

3.10.6 Add 
The Add action is available in the Your Templates group box. Click Add to access 
the Add Template dialog. 

Layout: Select an option on the Layout drop-down list to specify the layout to be 
used for the new template. 

After populating the Layout field, the Template Name field appears. 

 
Figure 3-35: Add Template dialog with added field 

Template Name: Type the name of the template in this free text field, limited to 80 
characters and must contain at least one (1) alpha character. 

After the dialog is complete, click Add to access the template to define the columns 
and their sorts for your new template. (Otherwise, click Exit.) 
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Figure 3-36: Sample template for new template created 

Click the Reset to System Default button to cause the template to reset to the system 
default. 

If you changed several things about the columns on the template and you want to 
undo those changes, click Reset. 

After the template window is complete, click OK and the new template will display 
in the Your Templates group box. (Otherwise, click Cancel.) 

3.10.6.1 Display and Available Columns 
Use the Display Columns to determine what columns you want to display for the 
particular window or tab. 
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Figure 3-37: Sample Display and Available columns 

The listing in the Display Columns area shows the columns that will be displayed for 
your template. The column names in italics are required and cannot be removed. 

To move a highlighted column name in the Available Columns area to the list in the 
Display Columns area, click Add. This moves the column name from the left panel 
to right panel. 

Likewise, you can remove a highlighted column name in the Display Columns area 
and move it to the Available Columns area by clicking Remove. This moves the 
column name from the right panel to the left panel. 

Note: You cannot remove any column names in italics. 

You can determine the order the columns display in the Display Columns area by 
using the Up and Down buttons. Highlight a column name and click the appropriate 
button. You might have to click the button more than once to move it to the desired 
location. 

3.10.6.2 Columns to Sort 
Sort a column to arrange the items in alpha-numeric order. 

Figure 3-38: Sample Available Sorts and Sort Columns area 

To move a highlighted column name in the Available Sorts area to the list in the Sort 
Columns area, click Add. This moves the column name from the left panel to right 
panel. 
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Likewise, you can remove a highlighted column in the Sort Columns area and move 
it to the Available Sorts area by clicking Remove. This moves the column name 
from the right panel to the left panel. 

Note: You cannot remove any column names in italics. 

3.10.6.3 Column Sort Order 
You use the Sort Columns area to determine what columns you want to sort for the 
particular window or tab. 

You determine which order the columns are sorted in the Sort Columns area by 
using the Up and Down buttons. Highlight a column name and click the appropriate 
button. You might have to click the button more than once to move it to the preferred 
location. For example, if you have Gender, Patient Name, and Diagnosis Tags in the 
right column, the Gender sort is applied first, then the Patient Name, and the 
Diagnosis Tags is last. 

3.10.6.4 Switch Sort Direction 
The names of columns in the Sort Columns area show “ASC” appended to the name, 
for example, Patient Name ASC. You can switch the sort order for a selected column 
by clicking the Switch Sort Direction button. In the example, the name changes to 
Patient Name DESC. You can use the Switch Sort Direction button on more than 
one column. 
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4.0 Package Operation 

4.1 Panel List Layout 

 
Figure 4-1: Sample Panel List layout 

The Panel List has the following data columns: 

Flag: The Flag Indicator ( ) icon displays in the first column if one or more patients 
in any of the panels have any flags. 

Category: User-defined category name (and colors) for grouping panels 

Panel Name: User-defined name of the panel (required). Hover help for this field 
displays the properties of the panel. 

Panel Description: User-defined description of the panel. 

# of Pts: The number of patients in the panel. 

Last Updated: The date and time the contents of the panel was last updated by a 
manual (user) repopulate, by an auto-repopulate, or the panel created date, if the panel 
has never been repopulated. 

Last Updated By: The name of user who either created or last repopulated the panel. 

Owner: The name of the user who created (owns) the panel. 

Shared With: This column has different icons representing whether a panel has been 
shared by you with other users or shared with you by a user. 

You can view how your patient panel is shared by hovering your mouse over the last 
column of the panel. 
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Figure 4-2: Sample Shared With Information 

The icons in the Shared With column have the following meanings: 

The  icon means you have Read/Write access to the panel. 

The  icon means you created the panel. If you have not shared it, the field will be 
blank; if you have, the field will be populated with . A mouse hover shows share 
names. 

The  icon means you have read-only access to the panel. 

You can sort and/or filter any column, re-arrange the order of the columns, etc. 
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5.0 Panel List Toolbar 
The toolbar buttons and menu options determine what actions can be taken on this 
window. 

 
Figure 5-1: Panel List toolbar 

5.1 New 
Use the New function to create a new panel. You can create a patient panel in one of 
the following ways: 

• Clicking the New ( ) button 

• Selecting the New option on the context menu 

• Selecting File | Panel | New 

• Pressing the key combination of Ctrl-N 
Any of the above actions displays a blank Panel Definition window where you can 
create a new panel. 

5.2 Open 
Use the Open function to show the patients in one or more selected panels. Highlight 
the panels by holding down the Ctrl key and then use the Open function. 

You can open selected panels by doing one of the following: 

• Clicking the Open ( ) button 

• Selecting File | Panel | Open 

• Selecting the Open option on the context menu 

• Double-clicking on the panel 

• Pressing the Ctrl-O key combination 

• Selecting File | Recent Panels and selecting the panel name (the list is limited to 
the last five panels that you have viewed) 

A Panel View window displays for each of the selected panels, showing the patients 
for the panel. 
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More than one user can open a shared panel simultaneously. The second and 
subsequent users to open the same panel will have read only access to the panel 
content. If the first user closes the panel, the second user will be notified that the 
panel is now available for edit access, unless the user only has been provided with 
Shared Read Only access by the panel creator. 

5.3 Delete 
You can delete the selected panels that are no longer useful. There are two conditions 
for the delete function: (1) when you delete a panel you created and (2) when you 
delete a panel that was shared with you. 

5.3.1 Delete Panel You Created 
To delete a panel you created, highlight one or more panels by holding down the Ctrl 
key and then using the Delete function. 

You can delete the selected panels by doing one of the following: 

• Clicking the Delete ( ) button 

• Selecting File | Panel | Delete 

• Selecting the Delete option on the context menu 

• Pressing the Delete key on your keyboard 
The Confirm panel delete dialog displays, asking if you want to delete the selected 
panels. Click Yes to delete the panels. Their names will no longer display in the 
Panel List view. (Otherwise, click No.) 

Shared users with shared access to the deleted panel will receive notification that you 
(the person who deleted the panel) are no longer sharing the panel. 
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Figure 5-2: Sample iCare Notification for deleting a shared panel 

If you are in the Delete Process and you clicked Yes and the selected panel is open in 
another window, the message in Figure 5-3 will display: 

 
Figure 5-3: Warning message about a panel open in another window 

Click OK to dismiss the warning and focus returns to the Panel List window. In 
order to delete the panel, you need to close it and then use the Delete process. 

5.3.2 Delete Panel Shared with You 
If you delete a panel that was shared with you, you will no longer see the panel on 
your list, i.e., the shared access is deleted but the panel remains for the panel creator 
and other shared users. 



iCare Population Management GUI (BQI) Version 2.8 

Panel List User Manual Panel List Toolbar 
September 2019 

41 

5.4 Repopulate 
Use the Repopulate function when the patients in a selected panel need to be updated 
with new data (for example, some patients have moved). Repopulate reruns the panel 
definition against the cached data (from the nightly job) where it adds patients who 
meet the criteria and removes the patients that no longer meet the criteria. 

You can repopulate the highlighted panel by doing one of the following: 

• Clicking the Repopulate ( ) button 

• Selecting File | Panel | Repopulate 

• Selecting the Repopulate option on the context menu 

• Setting the Auto Repopulate Options under the panel modifications (use the 
Modify button) 

The Repopulate Panel warning message displays asking if you want to update the 
patient list for the panel. Click Yes to repopulate the patient list. (Otherwise, click 
No.) This message does not display for Auto Repopulate. 

 

 

Figure 5-4: Repopulate Panel message 

The repopulate process (cannot be undone) will run as a background operation. 

The clock icon will appear to the left of the panel name while the process takes place; 
the date and time of the Last Updated column will be updated. 

Figure 5-5: Example of Panel List during the repopulate process 
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5.4.1 Other Warning Message 
If you manually edited (added or removed) patients in the panel, the Maintain 
Manual Changes warning message will display. 

 
Figure 5-6: Maintain Manual Changes warning message 

Click Cancel to exit the Repopulate function for the selected panel. 

Click No if you want the patient list totally refreshed. In this case, any added patient 
names will be lost as well as any deleted patient names will be added back to the 
panel. 

Click Yes if you want to preserve the manually added and removed patients. The 
Background populate? information message displays asking if you want to 
repopulate in the background. Click Yes if you want the repopulation to execute in 
the background. Otherwise, click No to repopulate in the foreground. 

This process does not run for panels that are manually populated. If you try to run the 
repopulate process in this situation, the application displays a warning message that 
states: Panel is manually selected and cannot be repopulated. Please open the panel 
and add or remove patients as necessary. Click OK to dismiss the message. 

5.4.2 Panel Open in Another Window 
If you are in the Repopulate Process and you clicked Yes and the selected panel is 
open in another window, the warning message in Figure 5-7 will display. 
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Figure 5-7: Warning Message about panel open in another window 

Click OK to dismiss the warning and to exit the repopulate process. 

5.4.3 Repopulate Not Active 
You will not be able to repopulate a panel if your shared access is read-only. In this 
case: 

• The Repopulate button will be inactive 

• The Repopulate option on the context menu will be inactive 

• The Repopulate option on File | Panel will be inactive 

5.5 Modify 
Use the Modify function to change the panel definition for a selected panel. 

You can modify a highlighted panel by doing one of the following: 

• Clicking the Modify ( ) button 

• Selecting File | Panel | Modify 

• Selecting the Modify option on the context menu 
If the selected panel is already open, a message stating the panel is already open will 
display. 

 
Figure 5-8: Panel already open message 
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Click OK and you move to the panel described in the message. You will modify the 
panel from this window. 

When you select the Modify process, the Panel Definition window display show the 
population criteria. 

 
Figure 5-9: Sample Panel Definition window to modify 

Below is an overview of the tabs on this window: 

Definition: Used to specify the panel’s name and description as well as what criteria 
to use to populate the panel. 

Layouts: Used to do two things: (1) select the layout for the “layout in use” for the 
Patient List, Reminders, Natl Measures, Care Mgmt groups, and CMET on the panel 
view tab and (2) the definition details for the defaults for the allergies, CPT, ER, 
inpatient, labs, medications, patient education, problems, and reminders on the panel 
view tab. 

Sharing: Used to share your panel with RPMS users. 

Auto Repopulate Options: Used to have your panel automatically refreshed. 

5.6 Share 
Use the Share function to define RPMS users who can share your panel. 
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You can share a highlighted panel by doing one of the following: 

• Clicking the Share ( ) button 

• Selecting File | Panel | Share 

• Selecting the Share option on the context menu 

You will not be able to share a panel if your Share access is read-only. In this case: 

• The Share button will be inactive 

• The Share option on File | Panel will be inactive 

• The Share option on the context menu will be inactive 
After accessing the Share function, the Panel List window opens to the Sharing tab 
on the Panel Definition window. 

 
Figure 5-10: Sample Sharing tab on the Panel Definition window 

When the Sharing tab is complete, click OK to save the Sharing information about 
the particular panel. (Otherwise, click Cancel.) 

5.6.1 Fields on Sharing Tab 
Shared with: Your selection from the drop-down list is the person with whom you 
want to share your panel. 
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Shared Access: The option buttons become active after you populate the Shared 
with field. 

 
Figure 5-11: Sample Shared With and access rights 

• Read Only: Use this option button to allow the person sharing your panel to only 
view your panel. The shared user can change the layout of the panel. 

• Read/Write: Use this option button to allow the person sharing your panel to 
view and change your panel (for example, add or delete patients). 

• Inactive: Use this option button to assign the person sharing your panel inactive 
access rights. 

Temporary: Select the Temporary check box to display a date range for the 
temporary status of the shared user. The access rights will only apply during the 
specified data range and will automatically expire once the specified date range has 
passed. 

 
Figure 5-12: Sample Temporary status 

You must select a date range when using the Temporary status. 

Shared Layouts?: Select the Shared Layouts? check box if you want to share the 
layouts of one or more of three panel views: Patient List, Reminders, and/or National 
Measures. The shared user will see the same layout modifications made by the 
creator. 

• This causes the Shared Layouts cell (in the grid) to contain Y (for yes). 

• The shared user will continue to be able to make modifications to the layouts of 
that shared panel. These modifications will not affect the creator’s layouts. 

5.6.2 Grid on Sharing Tab 
The grid shows a history of the users (that have not been removed/deleted) with 
whom you have shared the current panel. 
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Figure 5-13: Shared user information in lower grid 

Add: Click this button to add the information in the Shared with, Shared Access, 
Temporary, and Shared Layouts fields to the grid. 

Apply: Click this button to change the Shared Access and/or Temporary status of a 
selected user in the grid. You can change the shared access rights; for example, 
change the access rights from Read Only to Read/Write. 

Example: Highlight a user in the grid. The current access right (Read Only, 
Red/Write, Inactive) shows in the Shared Access area. Assume you want to 
change the selected user’s Read Only access right to Read/Write. Select the 
Read/Write option button. Then click the Apply button to reflect the changes to 
the user in the grid. 

Remove: Highlight one or more names in the grid and click this button to remove the 
name(s) from the grid. It might be more useful to inactivate the user instead of 
removing the user. After clicking the Remove button, the Delete Row information 
message displays, asking if you want to delete the selected names. Click Yes to delete 
(otherwise, click No). 

5.7 Copy 
Use the Copy function to create a new panel by copying one of your existing panels 
and saving it with a new name. What is copied is the patient population and the panel 
definition along with any added or deleted patients. 

You can copy a highlighted panel by doing one of the following: 

• Clicking the Copy ( ) button 

• Selecting File | Panel | Copy 

• Selecting the Copy option on the context menu 

The Copy Panel dialog displays. 
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Figure 5-14: Sample Copy Panel dialog 

The default name displays in the Panel Name field. You can edit the name. 

The Panel Name free text field contains a context menu for editing the text. 

The Copy Layouts check box determines if the layouts of the columns are in the 
copy process. The default is checked. If this field is not checked, the system default is 
used. 

Click OK to have the new panel added to the Panel List view. (Otherwise, click 
Cancel.) 

Once copied, you can modify the panel in any way, such as changing the panel 
definition, adding and deleting the patient names, etc. 

If the entered name is a duplicate name, the Panel Name is unique, please choose 
another name warning message displays. Click OK to dismiss the message and you 
return to the Copy Panel dialog. 

5.8 Category 
Use the Category function to establish the category color for a selected panel. 

• Click the Category ( ) button 

• Select File | Panel | Category 

• Select the Category option on the context menu 

The Category Pick dialog displays. 
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Figure 5-15: Category Picker dialog 

Use the controls at the bottom as follows: 

• Highlight a record in the grid and click Select to cause that color and name to 
display in the Category field on the Panel List window. 

• Highlight a record in the grid and click Clear to cause that color to be removed by 
the Category field on the Panel List window. The Clear Category option on the 
context menu or on File | Panel does the same thing. 

• Click Exit when the dialog is complete. 

New 

Click New to create a new category color and name. The application displays the 
New Category dialog. 

Figure 5-16: New Category dialog 

Type the name of the new category in the Name free text field. 

Click the down-down list for Color and pick a color to represent the new category. 

When the dialog is complete, click OK and the new category will display in the grid 
on the Category Picker dialog. (Otherwise, click Cancel.) 

Edit: Select a record in the grid on the Category Picker dialog and click Edit to 
display the Edit Category dialog. See New above to edit either field. 
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Delete: Select a record in the grid on the Category Picker dialog and click Delete to 
remove the record from the Category Picker dialog (there is no confirmation). 
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6.0 Panel List Menus 
The File, Tools, and View menus for the Panel List window are reviewed below. 

6.1 File Menu 
Below are the options on the File menu. 

 
Figure 6-1: File menu options 

Panel: The sub-menus contain the actions that you can take on this window. For 
example, the Properties option will display Panel Properties dialog that provides 
information about the panel such as the panel name, update history, shared users, and 
flag types. The Properties option is also available on the context menu. 

Change RPMS Server/Login: The Help Menu allows you to change the server 
information and your access and verify codes to the iCare application on the iCare 2.8 
GUI Login dialog. 

Change RPMS Division: This option allows you to change the RPMS Division on 
the Select Division dialog. This option applies to a site that uses more than one 
RPMS database. 

Recent Panels: This sub-menu shows your recent panels that you accessed. If you 
select one, you can view the patients in the selected panel in a new window. The list 
of panels is the last five panels that you have viewed. 

Page Setup: This option allows you to set Margin, Paper, Layout characteristics 
(such as landscape or portrait orientation), and the Printer to use. These settings are 
used when you use the Print option. 
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Print Preview: This option displays the Print Preview dialog. 

Print: This option sends the information about the selected rows in the grid to the 
printer using the settings in Page Setup. 

Background Jobs: This option displays the Background Jobs dialog. This dialog 
displays, for example, the start and end dates for the nightly and weekly background 
jobs. 

Exit iCare: The option allows you to leave the iCare application. You will be 
reminded to save any changed panels (if needed). 

Lock iCare: This option locks the iCare application by displaying the iCare locked 
by user dialog. You can do two things on this dialog: 

• Resume working on the iCare application by entering your verify code and then 
click Resume. 

• Click Logout to exit the iCare application. 

6.2 Tools Menu 
Below are the options on the Tools menu. 

 
Figure 6-2: Tools menu options 

Quick Patient Search: This option searches for a patient name. This is the same as 
pressing F8 on your keyboard. 
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The Reset View, Refresh, Search, Excel Export, Print, and Copy Rows to 
Clipboard options work like the buttons on the right side of the window. 

Manage Templates: This option allows you to manage the templates for various 
parts of the application. Select this option to access the Template Management 
dialog. Section 3.9.7 provides information about managing templates. 

User Preferences: This option opens the User Preferences window. 

View iCare Notifications: This option opens the iCare Notifications dialog that 
provides information about various notifications that have been sent. 

iCare Package Manager: This option is active for those users with Package Manager 
security key. Section 3.5 provides information about the iCare Package Manager 
Functions. 

iCare Site Parameters: This option accesses several iCare site parameters. 

 
Figure 6-3: iCare Site Parameters options 

The options provide dialogs where you can establish the various parameters. Section 
3.9 provides information the iCare Site Parameter options. 

Taxonomy Maintenance: This option is used by those users who can maintain 
taxonomies. Also, you use this option to view the taxonomy elements. This option has 
the following three features: 

View/Edit Taxonomy Entries: This feature displays the iCare Taxonomy 
View/Edit dialog. Section 3.6 provides information about the iCare Taxonomy 
function. 

Taxonomy User Access: This feature is active for those users with the proper 
security key. Selecting this option displays the iCare Taxonomy User Access 
Management  

Web Links: This option provides links to web sites for related clinical guidelines. 
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6.3 View Menu 
The View menu on the iCare Main window provides a way to change between the 
Split View and tab view. If the Split View option is selected, a Refresh option is also 
displayed. 

 
Figure 6-4: Sample View menu 

Split View: Select Split View to have the current view in the split view with Panel 
List in the left pane and the other tabs in the right pane. You can change to the Panel 
List view by removing the check mark; this is a temporary setting. When you exit 
iCare and reopen iCare, the settings set under User Preferences for the default screen 
are used. 

Refresh: Use this option to update any RPMS field values on the current window 
with new data from the server. This is the same as pressing F5 on your keyboard. 
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Appendix A:  Rules of Behavior 
The Resource and Patient Management (RPMS) system is a United States 
Department of Health and Human Services (HHS), Indian Health Service (IHS) 
information system that is FOR OFFICIAL USE ONLY. The RPMS system is 
subject to monitoring; therefore, no expectation of privacy shall be assumed. 
Individuals found performing unauthorized activities are subject to disciplinary action 
including criminal prosecution. 

All users (Contractors and IHS Employees) of RPMS will be provided a copy of the 
Rules of Behavior (RoB) and must acknowledge that they have received and read 
them prior to being granted access to a RPMS system, in accordance IHS policy. 

• For a listing of general ROB for all users, see the most recent edition of IHS 
General User Security Handbook (SOP 06-11a).  

• For a listing of system administrators/managers rules, see the most recent edition 
of the IHS Technical and Managerial Handbook (SOP 06-11b). 

Both documents are available at this IHS Web site: http://security.ihs.gov/. 

The ROB listed in the following sections are specific to RPMS. 

A.1 All RPMS Users 
In addition to these rules, each application may include additional RoBs that may be 
defined within the documentation of that application (e.g., Dental, Pharmacy). 

A.1.1 Access 
RPMS users shall 

• Only use data for which you have been granted authorization. 

• Only give information to personnel who have access authority and have a need to 
know.  

• Always verify a caller’s identification and job purpose with your supervisor or the 
entity provided as employer before providing any type of information system 
access, sensitive information, or nonpublic agency information. 

• Be aware that personal use of information resources is authorized on a limited 
basis within the provisions Indian Health Manual Part 8, “Information Resources 
Management,” Chapter 6, “Limited Personal Use of Information Technology 
Resources.” 

http://security.ihs.gov/
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RPMS users shall not 

• Retrieve information for someone who does not have authority to access the 
information. 

• Access, research, or change any user account, file, directory, table, or record not 
required to perform their official duties. 

• Store sensitive files on a PC hard drive, or portable devices or media, if access to 
the PC or files cannot be physically or technically limited. 

• Exceed their authorized access limits in RPMS by changing information or 
searching databases beyond the responsibilities of their jobs or by divulging 
information to anyone not authorized to know that information. 

A.1.2 Information Accessibility 
RPMS shall restrict access to information based on the type and identity of the user. 
However, regardless of the type of user, access shall be restricted to the minimum 
level necessary to perform the job. 

RPMS users shall 

• Access only those documents they created and those other documents to which 
they have a valid need-to-know and to which they have specifically granted 
access through an RPMS application based on their menus (job roles), keys, and 
FileMan access codes. Some users may be afforded additional privileges based on 
the functions they perform, such as system administrator or application 
administrator. 

• Acquire a written preauthorization in accordance with IHS policies and 
procedures prior to interconnection to or transferring data from RPMS. 

A.1.3 Accountability 
RPMS users shall 

• Behave in an ethical, technically proficient, informed, and trustworthy manner. 

• Log out of the system whenever they leave the vicinity of their personal 
computers (PCs). 

• Be alert to threats and vulnerabilities in the security of the system. 

• Report all security incidents to their local Information System Security Officer 
(ISSO)  

• Differentiate tasks and functions to ensure that no one person has sole access to or 
control over important resources. 

• Protect all sensitive data entrusted to them as part of their government 
employment. 



iCare Population Management GUI (BQI) Version 2.8 

Panel List User Manual Rules of Behavior 
September 2019 

57 

• Abide by all Department and Agency policies and procedures and guidelines 
related to ethics, conduct, behavior, and information technology (IT) information 
processes. 

A.1.4 Confidentiality 
RPMS users shall 

• Be aware of the sensitivity of electronic and hard copy information, and protect it 
accordingly. 

• Store hard copy reports/storage media containing confidential information in a 
locked room or cabinet. 

• Erase sensitive data on storage media prior to reusing or disposing of the media. 

• Protect all RPMS terminals from public viewing at all times. 

• Abide by all Health Insurance Portability and Accountability Act (HIPAA) 
regulations to ensure patient confidentiality. 

RPMS users shall not 

• Allow confidential information to remain on the PC screen when someone who is 
not authorized to that data is in the vicinity. 

• Store sensitive files on a portable device or media without encrypting. 

A.1.5 Integrity 
RPMS users shall 

• Protect their systems against viruses and similar malicious programs. 

• Observe all software license agreements.  

• Follow industry standard procedures for maintaining and managing RPMS 
hardware, operating system software, application software, and/or database 
software and database tables. 

• Comply with all copyright regulations and license agreements associated with 
RPMS software. 

RPMS users shall not 

• Violate federal copyright laws. 

• Install or use unauthorized software within the system libraries or folders. 

• Use freeware, shareware, or public domain software on/with the system without 
their manager’s written permission and without scanning it for viruses first. 
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A.1.6 System Logon 
RPMS users shall 

• Have a unique User Identification/Account name and password. 

• Be granted access based on authenticating the account name and password 
entered. 

• Be locked out of an account after five successive failed login attempts within a 
specified time period (e.g., one hour). 

A.1.7 Passwords 
RPMS users shall 

• Change passwords a minimum of every 90 days. 

• Create passwords with a minimum of eight characters. 

• If the system allows, use a combination of alpha-numeric characters for 
passwords, with at least one uppercase letter, one lower case letter, and one 
number. It is recommended, if possible, that a special character also be used in the 
password. 

• Change vendor-supplied passwords immediately. 

• Protect passwords by committing them to memory or store them in a safe place 
(do not store passwords in login scripts or batch files).  

• Change passwords immediately if password has been seen, guessed, or otherwise 
compromised, and report the compromise or suspected compromise to their ISSO. 

• Keep user identifications (IDs) and passwords confidential. 

RPMS users shall not 

• Use common words found in any dictionary as a password. 

• Use obvious readable passwords or passwords that incorporate personal data 
elements (e.g., user’s name, date of birth, address, telephone number, or social 
security number; names of children or spouses; favorite band, sports team, or 
automobile; or other personal attributes). 

• Share passwords/IDs with anyone or accept the use of another’s password/ID, 
even if offered. 

• Reuse passwords. A new password must contain no more than five characters per 
eight characters from the previous password. 

• Post passwords. 

• Keep a password list in an obvious place, such as under keyboards, in desk 
drawers, or in any other location where it might be disclosed. 
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• Give a password out over the phone. 

A.1.8 Backups 
RPMS users shall 

• Plan for contingencies such as physical disasters, loss of processing, and 
disclosure of information by preparing alternate work strategies and system 
recovery mechanisms. 

• Make backups of systems and files on a regular, defined basis.  

• If possible, store backups away from the system in a secure environment. 

A.1.9 Reporting 
RPMS users shall 

• Contact and inform their ISSO that they have identified an IT security incident 
and begin the reporting process by providing an IT Incident Reporting Form 
regarding this incident. 

• Report security incidents as detailed in the IHS Incident Handling Guide (SOP 
05-03). 

RPMS users shall not 

• Assume that someone else has already reported an incident. The risk of an 
incident going unreported far outweighs the possibility that an incident gets 
reported more than once. 

A.1.10 Session Timeouts 
RPMS system implements system-based timeouts that back users out of a prompt 
after no more than 5 minutes of inactivity. 

RPMS users shall 

• Utilize a screen saver with password protection set to suspend operations at no 
greater than 10 minutes of inactivity. This will prevent inappropriate access and 
viewing of any material displayed on the screen after some period of inactivity. 

A.1.11 Hardware 
RPMS users shall 

• Avoid placing system equipment near obvious environmental hazards (e.g., water 
pipes).  

• Keep an inventory of all system equipment.  



iCare Population Management GUI (BQI) Version 2.8 

Panel List User Manual Rules of Behavior 
September 2019 

60 

• Keep records of maintenance/repairs performed on system equipment. 

RPMS users shall not 

• Eat or drink near system equipment. 

A.1.12 Awareness 
RPMS users shall 

• Participate in organization-wide security training as required.  

• Read and adhere to security information pertaining to system hardware and 
software. 

• Take the annual information security awareness. 

• Read all applicable RPMS manuals for the applications used in their jobs. 

A.1.13 Remote Access 
Each subscriber organization establishes its own policies for determining which 
employees may work at home or in other remote workplace locations. Any remote 
work arrangement should include policies that 

• Are in writing. 

• Provide authentication of the remote user through the use of ID and password or 
other acceptable technical means. 

• Outline the work requirements and the security safeguards and procedures the 
employee is expected to follow. 

• Ensure adequate storage of files, removal, and nonrecovery of temporary files 
created in processing sensitive data, virus protection, and intrusion detection, and 
provide physical security for government equipment and sensitive data. 

• Establish mechanisms to back up data created and/or stored at alternate work 
locations. 

Remote RPMS users shall 

• Remotely access RPMS through a virtual private network (VPN) whenever 
possible. Use of direct dial in access must be justified and approved in writing and 
its use secured in accordance with industry best practices or government 
procedures. 

Remote RPMS users shall not 

• Disable any encryption established for network, internet, and Web browser 
communications. 
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A.2 RPMS Developers 
RPMS developers shall 

• Always be mindful of protecting the confidentiality, availability, and integrity of 
RPMS when writing or revising code. 

• Always follow the IHS RPMS Programming Standards and Conventions (SAC) 
when developing for RPMS. 

• Only access information or code within the namespaces for which they have been 
assigned as part of their duties. 

• Remember that all RPMS code is the property of the U.S. Government, not the 
developer. 

• Not access live production systems without obtaining appropriate written access, 
and shall only retain that access for the shortest period possible to accomplish the 
task that requires the access. 

• Observe separation of duties policies and procedures to the fullest extent possible. 

• Document or comment all changes to any RPMS software at the time the change 
or update is made. Documentation shall include the programmer’s initials, date of 
change, and reason for the change. 

• Use checksums or other integrity mechanism when releasing their certified 
applications to assure the integrity of the routines within their RPMS applications. 

• Follow industry best standards for systems they are assigned to develop or 
maintain, and abide by all Department and Agency policies and procedures. 

• Document and implement security processes whenever available. 

RPMS developers shall not 

• Write any code that adversely impacts RPMS, such as backdoor access, “Easter 
eggs,” time bombs, or any other malicious code or make inappropriate comments 
within the code, manuals, or help frames. 

• Grant any user or system administrator access to RPMS unless proper 
documentation is provided.  

• Release any sensitive agency or patient information. 

A.3 Privileged Users 
Personnel who have significant access to processes and data in RPMS, such as, 
system security administrators, systems administrators, and database administrators, 
have added responsibilities to ensure the secure operation of RPMS. 
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Privileged RPMS users shall 

• Verify that any user requesting access to any RPMS system has completed the 
appropriate access request forms. 

• Ensure that government personnel and contractor personnel understand and 
comply with license requirements. End users, supervisors, and functional 
managers are ultimately responsible for this compliance. 

• Advise the system owner on matters concerning information technology security. 

• Assist the system owner in developing security plans, risk assessments, and 
supporting documentation for the certification and accreditation process. 

• Ensure that any changes to RPMS that affect contingency and disaster recovery 
plans are conveyed to the person responsible for maintaining continuity of 
operations plans.  

• Ensure that adequate physical and administrative safeguards are operational 
within their areas of responsibility and that access to information and data is 
restricted to authorized personnel on a need-to-know basis.  

• Verify that users have received appropriate security training before allowing 
access to RPMS. 

• Implement applicable security access procedures and mechanisms, incorporate 
appropriate levels of system auditing, and review audit logs.  

• Document and investigate known or suspected security incidents or violations and 
report them to the ISSO, Chief Information Security Officer (CISO), and systems 
owner. 

• Protect the supervisor, superuser, or system administrator passwords. 

• Avoid instances where the same individual has responsibility for several functions 
(i.e., transaction entry and transaction approval). 

• Watch for unscheduled, unusual, and unauthorized programs. 

• Help train system users on the appropriate use and security of the system. 

• Establish protective controls to ensure the accountability, integrity, 
confidentiality, and availability of the system. 

• Replace passwords when a compromise is suspected. Delete user accounts as 
quickly as possible from the time that the user is no longer authorized system. 
Passwords forgotten by their owner should be replaced, not reissued. 

• Terminate user accounts when a user transfers or has been terminated. If the user 
has authority to grant authorizations to others, review these other authorizations. 
Retrieve any devices used to gain access to the system or equipment. Cancel 
logon IDs and passwords, and delete or reassign related active and backup files. 
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• Use a suspend program to prevent an unauthorized user from logging on with the 
current user's ID if the system is left on and unattended. 

• Verify the identity of the user when resetting passwords. This can be done either 
in person or having the user answer a question that can be compared to one in the 
administrator’s database. 

• Shall follow industry best standards for systems they are assigned to, and abide by 
all Department and Agency policies and procedures. 

Privileged RPMS users shall not 

• Access any files, records, systems, etc., that are not explicitly needed to perform 
their duties 

• Grant any user or system administrator access to RPMS unless proper 
documentation is provided.  

• Release any sensitive agency or patient information. 
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Glossary 

Context Menu 
The menu of options that displays when you right-click on an entity. 

Designated Primary Care Provider (DPCP) 
In RPMS, the provider name that is assigned as the primary care physician for 
a patient or group of patients at a specific facility. This is not a required 
function. 

Free Text Field 
A field where the user can type text just like typing a note to someone. 

iCare Package Manager 
The designated person with authority to manage all information settings for 
iCare. 

Panel List 
The list of patient panels owned by the user. 

Providers 
Any staff member in an I/T/U facility who provides direct healthcare to 
patients, e.g. general practice or specialty physicians, registered nurses, social 
workers, physician assistants, etc. 

Taxonomy 
In RPMS, a grouping of functionally related data elements, such as ICD 
codes, that are created and maintained within the RPMS Taxonomy Setup 
application. Taxonomies will be used as definitions for diagnoses, procedures, 
lab tests, medications, and other clinical data types. 

If you need a change or addition to an existing taxonomy, please see your 
CRS coordinator. 

Tooltip/Hover Help 
A common GUI element used to provide additional information to users. To 
display a Tooltip, hover the mouse pointer, without clicking, over a column 
heading or field. 
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Acronym List 

Acronym Meaning 
CMET Care Management Event Tracking 
CQM Clinical Quality Measures 
CRS Clinical Reporting System 
DPCP Designated Primary Care Provider 
GPRA Government Performance and Results Act 
GUI Graphical User Interface 
HHS Health and Human Services 
ICD International Classification of Diseases 
IHS Indian Health Service 
IPC Improving Patient Care 
I/T/U Indian Health Service, or Tribal or Urban Indian health programs 
OIT Office of Information Technology 
PM Performance Measures 
RPMS Resource and Patient Management System 
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Contact Information 

If you have any questions or comments regarding this distribution, please contact the 
IHS IT Service Desk. 

Phone: (888) 830-7280 (toll free) 
Web: https://www.ihs.gov/itsupport/ 
Email: itsupport@ihs.gov 
 

https://www.ihs.gov/itsupport/
mailto:itsupport@ihs.gov
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